
A TROUBLESHOOTING AND
ERROR CORRECTION

TextBridge is designed to be easy to install and use,
and, under typical circumstances, you should rarely
experience problems.

However, should you encounter a problem during
installation and/or use of TextBridge, first consult this
appendix to try to resolve the problem yourself.

TextBridge error messages appear in a standard
Windows error dialog box, as shown in Figure A–1.

Click OK, then 
correct error 
condition

Figure A–1.  Error message example

For information to resolve an error condition, refer to
the appropriate section in this appendix. This
appendix is organized in three sections:

• What to do if you encounter a problem

• Troubleshooting common problems

• Correcting error conditions
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WHAT TO DO IF YOU ENCOUNTER A PROBLEM

If you are a new or inexperienced user, and you
encounter a problem, first refer to “Troubleshooting
Common Problems,” the next section in this appendix.
That section suggests solutions to common problems
found by TextBridge users.

If you are a more experienced TextBridge user and
you encounter an error, refer to the “Correcting Error
Conditions” section to locate the error, and follow the
recommended solution.

When you get an error message, write down the text
of the message, along with the error code number.

Also, note the sequence of steps you took to generate
the message. This information can be useful later if
you cannot solve the problem and must call your
scanner manufacturer for support.

If you get an error message that you cannot locate in
this appendix, and/or you cannot resolve a problem on
your own, contact your scanner manufacturer.

If you should need to call, be ready to provide:

• your software registration number (the serial
number on Disk 1 of the original TextBridge
installation diskettes)

• a list of the steps that led up to the problem

• a verbatim description of the error message
(and/or number)
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TROUBLESHOOTING COMMON PROBLEMS

This section describes typical problems with
TextBridge, and provides suggestions to resolve them.
It also discusses other issues. Specifically, this section
is organized into four topics:

• ISIS scanner problems

• TWAIN scanner problems

• Virtual memory problems

• Other problems

ISIS scanner problems

TextBridge provides a number of ISIS scanner drivers
developed by Pixel Translations and other sources.

Following are some common error messages relating
to ISIS scanner setup and use, and suggestions to
correct the error conditions:

Can’t open system-level scanner driver; check
installation

In Scanner Setup, after using the Select Source
command, you run the Acquire command to test
the scanner, and this message appears.

Assuming you have correctly installed the scanner
interface card and connected and powered on the
scanner, do the following: Load the scanner
system-level driver (.sys file) file onto your PC,
reference the complete file pathname in a device
statement in your config.sys file, then restart
your PC.

The system-level driver, and instructions to install
it, should be provided by the interface card or
scanner manufacturer.
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ISIS error or Cannot write to device USCAN.XXX

In Scanner Setup, when you test the scanner with
Acquire, one of these messages can appear.

If you have an Envision scanner, install the ISIS
driver provided by Envision Systems, Inc.

Choose Select Source, insert the Envision diskette
into the disk drive, and type the directory path:

drive:\txbridge\6100

In the Add dialog, select the ISIS driver and
proceed accordingly.

If you encounter one of these errors with another
scanner, the TextBridge ISIS driver could be out-
dated.

Call the scanner manufacturer to see if an
updated ISIS driver is available.

If not, call Customer Support.

Also, these errors can be generated by an address
conflict with another device.

Try changing the memory address of your scanner
card according to manufacturer instructions.

Finally, these error messages can be generated by
an extended memory manager, such as EMM386,
that allocates your scanner card memory address
to another device.

In that case, you need to exclude your scanner
card’s memory address in the EMM386 statement
in your config.sys file.
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TWAIN scanner problems

TWAIN is an emerging industry standard for the
development of scanner and other image-capture
device drivers.

TextBridge supports fully-TWAIN compliant hand-
held scanners and other devices.

For your TWAIN scanner to work with TextBridge, it
must have the following software:

• TWAIN source manager (TWAIN.DLL)—This
software manages the communication between
your scanner’s TWAIN source driver and
TextBridge. It is provided by your scanner
manufacturer and must be loaded into the
Windows directory, typically C:\WINDOWS.

• TWAIN source driver—This is the actual
scanner driver. It is provided by your scanner
manufacturer and typically is loaded in
C:\WINDOWS\TWAIN, or a subdirectory of this
directory path.

This section describes some of the problems that you
can encounter with a TWAIN scanner while using it
with TextBridge, specifically:

• Problems with scanner setup

• Problems with buffered memory

• TWAIN errors
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Problems with Scanner Setup

The Scanner Setup program links your scanner’s
TWAIN source driver with TextBridge.

If your scanner’s TWAIN software is not properly
installed, you can encounter one of the following
problems:

Under the Type menu, TWAIN is dimmed

TextBridge cannot find the TWAIN source
manager (TWAIN.DLL) in the Windows directory,
or there is no TWAIN subdirectory in the Windows
directory.

Check to see that a file named TWAIN.DLL resides
in the C:\WINDOWS directory. Check also to see if
there is a C:\WINDOWS\TWAIN subdirectory.

If either of these conditions is untrue, repeat all
TWAIN installation steps described in your
scanner documentation. Verify the existence of the
TWAIN source manager and the TWAIN source
subdirectory, as above. Restart your PC. Then
try running Scanner Setup again.

If the TWAIN type is still dimmed in the Scanner
Setup Type menu, call Customer Support.

No TWAIN sources installed

Under the Type menu, you have selected TWAIN.
When you run the Select Source command under
the File menu, this message is displayed. This
means that TextBridge cannot locate any TWAIN
drivers in the C:\WINDOWS\TWAIN subdirectory.

Repeat all TWAIN scanner installation steps as
instructed by your scanner documentation.
Restart your PC. Then try running Scanner
Setup again.

If you continue to get this message, call Customer
Support.
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No TWAIN source selected

When you run the Acquire command under the
File menu, this error message is displayed.

Run Select Source first, select a TWAIN source
driver, then run the Acquire command again.

Problems with buffered memory mode

To support TWAIN on 4Mb systems, TextBridge
requests the TWAIN source driver to use buffered
memory mode.

If the TWAIN source driver correctly supports
buffered memory mode, it uses no more than 64
kilobytes (Kb) of memory at a time, passing the
scanned image to TextBridge in segments.

TextBridge then copies these segments into the
memory it has set aside to store the page image it is
about to recognize.

Ideally, buffered memory mode reduces the total
amount of memory the TWAIN source driver and
TextBridge use to manage the scanned image.

Some TWAIN source drivers do not properly support
buffered memory mode, and have problems delivering
a clean image to TextBridge.

In such cases, the image tends to be severely slanted
or otherwise garbled, and TextBridge cannot perform
legible OCR on it.

If you encounter this problem, you can direct
TextBridge to request native memory mode.

In native memory mode, the TWAIN source driver
allocates enough memory to store the entire page
image before it passes it to TextBridge.
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To specify native memory mode:

1. Edit the TextBridge initialization file:

c:\windows\txbridge.ini

2. At the bottom of the file, insert the following
line exactly as shown.

memory=native

3. Save the changes to the file.

4. Quit TextBridge and start it again, then try
scanning with your TWAIN scanner.

Note Native memory mode requires 1Mb of memory. If your
PC is a 4Mb machine, you can encounter memory
problems running in native memory mode. In this
case, you should upgrade your PC to 8Mb of RAM.

TWAIN source driver errors

The TWAIN standard is in its infancy. Developers of
TWAIN source drivers fine-tune them so that the
scanners work with a particular application.
Typically, the scanner, source driver, and application
are sold as a bundle, and they all work fine together.

However, if you get an error from the TWAIN source
driver while using your device with TextBridge, it
could be that the source driver is not fully-TWAIN
compliant.

Contact the manufacturer to see if an updated
TWAIN source driver is available for your device. If
not, call Customer Support.
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Virtual memory problems

Some problems in using TextBridge are related to not
allocating enough virtual memory in Windows.

Because TextBridge must process large image files
during OCR, the program requires a minimum of
eight megabytes (8Mb), and preferably 12 to 16Mb, of
permanent virtual memory, especially on PCs that
only have 4Mb of RAM (random access memory).

Permanent virtual memory is a contiguous block of
swap space on your hard drive. It cannot be located on
a compressed drive.

Note On systems with 8Mb of RAM, it is possible, although
not recommended, to run TextBridge using
temporary (non-contiguous) virtual memory.

Following are a few examples of problems that can be
related to virtual memory:

• error message “Invalid index for language”

☞ This error can also be caused for other
reasons; see the section, “Other problems.”

• error message “General protection fault”

• TextBridge hangs while acquiring the image

• the scanner stops during a scan

If you have installed TextBridge and experience
problems while using it, check and, if necessary,
change your virtual memory setting in Windows. Use
the following procedure:

Troubleshooting and Error Correction A–9



1. From the Program Manager, open the Main
program group, and select Control Panel.

2. Double-click the 386 Enhanced icon.

3. Click the Virtual Memory button to display
the current swap file size and type
(permanent or temporary).

If virtual memory is less than 8Mb (preferably
16Mb) in size, or is temporary, you may need to
change it, as described in the next step.

4. Change virtual memory.

• Click the Change button to display Maximum
Size, Recommended Size (not in DOS 6.0), and
New Size values.

• If Type is not Permanent, specify Permanent.
This is required on 4Mb systems, recom-
mended on 8Mb systems.

• Using the now-displayed Recommended Size
value (not on DOS 6.0), enter this value as the
New Size, or simply accept the New Size
amount.

☞ If there is not enough contiguous space to
create a large enough permanent swap file
(8–16Mb), you will need to defragment
your disk. Use a utility such as Norton
Utilities’ SpeedDisk to perform this
operation.

With the appropriate virtual memory set up on your
Windows-based PC, you should be able to use
TextBridge successfully.

If you still encounter any of the problems listed above,
or problems that you cannot otherwise resolve, contact
TextBridge Customer Support.
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Other problems during TextBridge operation

Following are some other common problems that
TextBridge users have encountered:

Invalid index for language

If your PC has 4Mb of physical RAM (random
access memory), and you get this message while
using TextBridge, you are probably running DOS
Version 6 with Memmaker, or have a number of
devices being loaded into high memory.

If you are using Memmaker, you will have to undo
it, as TextBridge requires the space in upper
memory that Memmaker allocates to files. Close
out of Windows, back up your autoexec.bat and
config.sys files, then, at the DOS prompt, type:

Memmaker /undo ↵

If you are not using Memmaker, and you get this
error, it may be because you are using too many
LH (load high) statements in your autoexec.bat
file, or DH (device high) statements in your
config.sys file.

Back up these files, then try reducing the number
of LH and/or DH statements in these files. Restart
your system and try using TextBridge again.

If you still get the error message while running
TextBridge, it could be a problem with virtual
memory. Refer to the previous section, “Virtual
memory problems,” for information.
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Errors 667, 673, 675, or 690

If when reading a TIFF file, you get any of these
errors, the TIFF file cannot be processed. Text-
Bridge can process binary (black and white) TIFF
files of the following resolutions and formats:

Resolutions Formats

100-by-200
200-by-100
200-by-200
300-by-300
400-by-200
400-by-400

TIFF Uncompressed (Intel header)
TIFF CCITT-3 (Intel header)
TIFF CCITT-4 (Intel header)
TIFF Uncompressed (Motorola header)
TIFF CCITT-3 (Motorola header)
TIFF CCITT-4 (Motorola header)
TIFF (Intel FAXability header)

In addition, the TIFF image must contain black
type on a white background. Some fax programs
save images in reverse (white type on a black
background). TextBridge cannot recognize such
files. Try processing these files using the Preview
option in TextBridge. If a page image appears in
reverse, use the Invert command under the View
menu to correct the image. Then try processing
the page again.

CORRECTING ERROR CONDITIONS

Occasionally, during TextBridge operation, you may
receive an error message. TextBridge error messages
are designed to be self-explanatory. Usually, you can
simply correct the situation and proceed.

However, if you require more detail about how to
correct an error condition, consult this section. Each
error message is listed here, along with a description
of the cause and a recommended course of action.

Note If you encounter an error message not described in
this section, and you cannot resolve the problem on
your own, contact Customer Support.
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Canceling. Page too complex for selected mode.

You are trying to process a complex page with
halftones, or which is improperly oriented,
without specifying the correct preferences for
TextBridge to operate.

In Preferences, specify Auto Page Segmentation
and/or Auto Page Orientation, and try again.

If you still encounter problems with a particular
document, contact Customer Support.

Cannot find file filename (or one of its
components). Check to ensure the path and
filename are correct and that all required
libraries are available.

You are trying to launch TextBridge, or open one
of the files in its program group, and the program
or file represented by filename cannot be found.

Re-install TextBridge from the original
installation diskettes. Refer to Chapter 2 of this
manual for information.

Cannot find this file. Please verify that the
correct path and filename are given.

This indicates that a file that appears in the Open
dialog box was recently deleted, while the Open
dialog file listing itself was not updated. This
could happen if, for example, the file you were
trying to access was on a network and another
network user deleted or moved it.

Try clicking GO! again to access the Open dialog.
The file should no longer be listed. If it is listed,
and you select it again, and you still get this
message, your disk may be corrupted, or you may
have network problems.
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Can’t Initialize Server.

You have started TextBridge, and the recognition
server, named ICRSRVR.EXE, in the TextBridge
BIN directory is corrupted or missing.

Re-install TextBridge from the original
installation diskettes. Refer to Chapter 2 of this
manual for information.

Cannot open Help file.

The file named TXBRIDGE.HLP has been removed
from the TextBridge BIN directory or is damaged.

Re-install TextBridge from the original
installation diskettes.

File Error Cannot find filename

You are trying to launch TextBridge, or open one
of the files in its program group, and the program
or file represented by filename cannot be found.

Re-install TextBridge from the original
installation diskettes. Refer to Chapter 2 of this
manual for information.

Invalid input format

You have directed TextBridge to open a file that
has the .TIF extension but is not a valid TIFF
file. Although TIFF is an industry-standard, some
applications write non-standard variations of the
TIFF format. TextBridge can read the following
TIFF variations:

TIFF Uncompressed (Intel header)
TIFF CCITT-3 (Intel header)
TIFF CCITT-4 (Intel header)
TIFF Uncompressed (Motorola header)
TIFF CCITT-3 (Motorola header)
TIFF CCITT-4 (Motorola header)
TIFF (Intel FAXability header)
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Must select a different language

In Preferences, you have selected a recognition
language that is not loaded on your system.

Run the TextBridge SETUP program to re-install
TextBridge, making sure to include all the
recognition languages you intend to use. Refer to
Chapter 2 of this manual for information.

If you did install the language pack, and
experience this problem, the language pack file in
the TextBridge BIN directory has been deleted
inadvertently, renamed, or corrupted.

Re-install TextBridge from the original
installation diskettes. Refer to Chapter 2 of this
manual for information.

Parameter combination not supported

This error is usually the result of trying to have
TextBridge process a TIFF file that is inappro-
priate for OCR. For example, the TIFF file could
be extremely low resolution (lower than 100-by-
200 dpi), could be color or grayscale, or some
combination of the two.

TextBridge can only process binary (black and
white) TIFF images with resolutions greater than
100-by 200 dpi.

Scanner not operational

A number of conditions can cause this problem.

Make sure you have followed the manufacturer's
recommended instructions for installing the
scanner on your PC, including installing the
system-level driver.

Make sure you have followed all the scanner
installation steps described in Chapter 2 of this
manual.
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If you still get this message, your scanner may be
powered off. Turn it on and try again.
This can also happen if TextBridge is running and
your scanner is powered off and back on, or
otherwise loses power for a brief moment. Try
exiting from TextBridge and starting it again.

Otherwise, your scanner may be improperly
connected. Power down your PC, check all
connections. Then try again.

Server not found or down.

You have started up TextBridge, and the
recognition server, named ICRSRVR.EXE, in the
TextBridge BIN directory is corrupted or missing.

Re-install TextBridge from the original
installation diskettes. Refer to Chapter 2 of this
manual for information.
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